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Soft Solutions, Inc. Software License 

 
1. License. The software, documentation and any fonts accompanying this License 

whether on disk, in read only memory, on any other media or in any other form (the 
"Soft Solutions Software") are licensed to you by Soft Solutions, Inc. or its local 

Distributor/Reseller, if any ("Soft Solutions"). You own the media on which the 

Soft Solutions Software is recorded but Soft Solutions and/or Soft Solution's 
licensor(s) retain title to the Soft Solutions Software. The Soft Solutions Software in 

this package and any copies that this License authorizes you to make are subject to 

this License. 
2. Permitted Uses and Restrictions. This License allows you to install and use the 

Soft Solutions Client Software as governed by the licensing set forth on the 4-Sight 

FAX Server software license. You may make copies of the Soft Solutions Software 
in machine-readable form for backup purposes only. The backup copy must include 

all copyright information contained on the original. Except as expressly permitted in 

this License, you may not decompile, reverse engineer, disassemble, modify, rent, 
lease, loan, sublicense, distribute or create derivative works based upon the Soft 

Solutions Software in whole or part or transmit the Soft Solutions Software over a 

network. You may not transfer your rights under this License including the related 
documentation. THE SOFT SOLUTIONS SOFTWARE IS NOT INTENDED FOR 

USE IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT 

NAVIGATION OR AIRCRAFT COMMUNICATION SYSTEMS, OR AIR 
TRAFFIC CONTROL MACHINES IN WHICH CASE THE FAILURE OF THE 

SOFT SOLUTIONS SOFTWARE COULD LEAD TO DEATH, PERSONAL 

INJURY, OR SEVERE PHYSICAL OR ENVIRONMENTAL DAMAGE. Your 
rights under this License will terminate automatically without notice from Soft 

Solutions if you fail to comply with any term(s) of this License. 

3. Limited Warranty on Media (if applicable). Soft Solutions warrants the media on 
which the Soft Solutions Software is recorded to be free from defects in materials 

and workmanship under normal use for a period of ninety (90) days from the date of 

original retail purchase. Your exclusive remedy under this paragraph shall be, at 
Soft Solution‟s option, a refund of the purchase price of the product containing the 

Soft Solutions Software or replacement of the Soft Solutions Software which is 

returned to Soft Solutions or a Soft Solutions authorized representative with a copy 
of the receipt. THIS LIMITED WARRANTY AND ANY IMPLIED 

WARRANTIES ON THE MEDIA INCLUDING THE IMPLIED WARRANTIES 

OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 

ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF 

ORIGINAL RETAIL PURCHASE. SOME JURISDICTIONS DO NOT ALLOW 
LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THIS 

LIMITATION MAY NOT APPLY TO YOU. THE LIMITED WARRANTY SET 

FORTH HEREIN IS EXCLUSIVE AND IN LIEU OF ALL OTHERS, WHETHER 
ORAL OR WRITTEN, EXPRESS OR IMPLIED. SOFT SOLUTIONS 

SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES. THIS LIMITED 

WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO 
HAVE OTHER RIGHTS WHICH VARY BY JURISDICTION. 

4. Disclaimer of Warranty on Soft Solutions Software. You expressly acknowledge 

and agree that use of the Soft Solutions Software is at your sole risk. The Soft 
Solutions Software is provided "AS IS" and without warranty of any kind and Soft 

Solutions and Soft Solution‟s licensor(s) (for the purposes of provisions 4 and 5, 

Soft Solutions and Soft Solution‟s licensor(s) shall be collectively referred to as 
"Soft Solutions") EXPRESSLY DISCLAIM ALL WARRANTIES AND/OR 

CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED 

TO, THE IMPLIED WARRANTIES AND/OR CONDITIONS OF 
MERCHANTABILITY OR SATISFACTORY QUALITY AND FITNESS FOR A 

PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY 

RIGHTS. SOFT SOLUTIONS DOES NOT WARRANT THAT THE FUNCTIONS 
CONTAINED IN THE SOFT SOLUTIONS SOFTWARE WILL MEET YOUR 
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REQUIREMENTS, OR THAT THE OPERATION OF THE SOFT SOLUTIONS 

SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT 

DEFECTS IN THE SOFT SOLUTIONS SOFTWARE WILL BE CORRECTED. 
FURTHERMORE, SOFT SOLUTIONS DOES NOT WARRANT OR MAKE 

ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF 

THE USE OF THE SOFT SOLUTIONS SOFTWARE OR RELATED 
DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, ACCURACY, 

RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN INFORMATION 

OR ADVICE GIVEN BY SOFT SOLUTIONS OR A SOFT SOLUTIONS 
AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY OR IN 

ANY WAY INCREASE THE SCOPE OF THIS WARRANTY. SHOULD THE 

SOFT SOLUTIONS SOFTWARE PROVE DEFECTIVE, YOU (AND NOT SOFT 
SOLUTIONS OR AN SOFT SOLUTIONS AUTHORIZED REPRESENTATIVE) 

ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR 
OR CORRECTION. SOME JURISDICTIONS DO NOT ALLOW THE 

EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION 

MAY NOT APPLY TO YOU. THE TERMS OF THIS DISCLAIMER DO NOT 
AFFECT OR PREJUDICE THE STATUTORY RIGHTS OF A CONSUMER 

ACQUIRING SOFT SOLUTIONS PRODUCTS OTHERWISE THAN IN THE 

COURSE OF A BUSINESS, NEITHER DO THEY LIMIT OR EXCLUDE ANY 
LIABILITY FOR DEATH OR PERSONAL INJURY CAUSED BY SOFT 

SOLUTIONSÍS NEGLIGENCE. 

5. Limitation of Liability. UNDER NO CIRCUMSTANCES, INCLUDING 
NEGLIGENCE, SHALL SOFT SOLUTIONS BE LIABLE FOR ANY 

INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES 

ARISING OUT OF OR RELATING TO THIS LICENSE. SOME 
JURISDICTIONS DO NOT ALLOW THE LIMITATION OF INCIDENTAL OR 

CONSEQUENTIAL DAMAGES SO THIS LIMITATION MAY NOT APPLY TO 

YOU. In no event shall Soft Solution‟s total liability to you for all damages exceed 
the amount of fifty dollars (USD $50.00). 

6. Export Law Assurances. You may not use or otherwise export or re-export the 

Soft Solutions Software except as authorized by United States law and the laws of 
the jurisdiction in which the Soft Solutions Software was obtained. In particular, but 

without limitation, the Soft Solutions Software may not be exported or re-exported 

(i) into (or to a national or resident of) any U.S. embargoed country or (ii) to anyone 
on the U.S. Treasury Department's list of Specially Designated Nationals or the U.S. 

Department of Commerce's Table of Denial Orders. By using the Soft Solutions 

Software, you represent and warrant that you are not located in, under control of, or 

a national or resident of any such country or on any such list. 

7. Government End Users. If the Soft Solutions Software is supplied to the United 

States Government, the Soft Solutions Software is classified as "restricted computer 
software" as defined in clause 52.227-19 of the FAR. The United States 

Government's rights to the Soft Solutions Software are as provided in clause 

52.227-19 of the FAR. 
8. Controlling Law and Severability. If there is a local subsidiary of Soft Solutions 

in the country in which the Soft Solutions Software License was obtained, then the 

local law in which the subsidiary sits shall govern this License. Otherwise, this 
License shall be governed by the laws of the United States and the State of Georgia. 

If for any reason a court of competent jurisdiction finds any provision, or portion 

thereof, to be unenforceable, the remainder of this License shall continue in full 
force and effect. 

9. Complete Agreement. This License constitutes the entire agreement between the 

parties with respect to the use of the Soft Solutions Software and supersedes all 
prior or contemporaneous understandings regarding such subject matter. No 

amendment to or modification of this License will be binding unless in writing and 

signed by Soft Solutions. 
This software package is covered by the XML-RPC C library License. Additionally, 

certain parts of this library are derived from pre-existing code, which may carry its 

own license. 
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Copyright (c) 1988-1997 Sam Leffler Copyright (c) 1991-1997 Silbutton Graphics, 

Inc. Libtiff. IN NO EVENT SHALL SAM LEFFLER OR SILBUTTON 

GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT 

OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES 

WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, 

WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, 

AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN 

CONNECTION WITH THE USE OR PERFORMANCE OF THIS 

SOFTWARE. 

SOFT SOLUTIONS, INC. 

Copyright  2000-2010 Soft Solutions, Inc. World Wide Rights 

Reserved. 
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Welcome to 4-Sight FAX Client 

In this chapter: 

Topic Page 

Introduction 2 
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Introduction

4-Sight FAX allows you to send and receive fax messages from 

your Macintosh and PC. It has all the same features as previous  

4-Sight FAX versions, plus several new features designed to 

enhance the user experience and increase productivity. 

 Email to Fax: Send faxes from your email client through a 

simple, easy to use format 

 User personal save folder for incoming faxes 

 64-bit Print Driver Capabilities for Mac and Windows 

 Significant overall speed and performance increase.  

 XML/RPC updates 

 Smart notification for incoming faxes 

 Direct faxing of PDF, PNG, and TIFF file attachment, 

eliminating print driver requirement 

 

 Automatic end-user fax notification. 

 Document drag-and-drop faxing. 

 Apple Address Book support.  

 Convenient automated program update notification and 

installation. 

 View number of new messages from the MAC dock or 

Windows Taskbar. 

 User configurable/alternate port number preference for the fax 

server. 

 Line control for faxing. 

 Email Suite – allows you to send and receive emails as PDF 

files. 

 Preview frame in the Fax Client window allows you to 

instantly view thumbnails of incoming and outgoing faxes. 

 Enhanced Fax Composer contains a variety of views when 

creating a new fax. This provides much larger viewing areas 

for recipients, attachments and comments. 

 SMTP authentication for added security when sending Email. 

 Send and receive faxes from your desktop. 

 Address grouping provides convenient contact list 

segmentation. 

 Customizable interface (font type, size, labels, default cover 

pages and messaging. 

 Client-side imaging, which eliminates the need to duplicate 

fonts and applications on the Fax Server. 

New 7.5 Client 

Features:  

Existing Features: 
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 Windows® Client software for; Windows 98, ME, 2000 and 

XP. Macintosh Clients for OS 9, and OS X. 

 Server and Client-based address books. 

 Remote access via TCP/IP – where connecting to your fax 

Server is as close as an Internet connection. 

 Support for Direct Inward Dial.
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1. Installing 4-Sight FAX Client 

In this chapter: 

Topic Page 

Software Requirements 6 

Installation 7 

Upgrading from Previous Versions 8 
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Software Requirements 

 

4-Sight FAX Client for 

Macintosh 

4-Sight FAX Client for  

Windows 

Mac OS  

 9.23 

Mac OS X 

10.3 – 10.6 

Windows 

98, and ME 

Windows 2000 

and XP, Vista, 

and 7(not 

compatible with 

Windows NT) 

96MB - 

128MB RAM 

256 MB 

RAM 

96MB - 

128MB 

RAM 

128MB - 256MB 

RAM 

20MB HDD 

space 

20MB HDD 

space 

20MB 

HDD space 

20MB HDD 

space 

Minimum Software 

Requirements 
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Installation 

1. Downloaded the 4-Sight FAX Client from the 4-Sight FAX 

website and copy it directly onto each machine that will run 

the Fax Client software. Launch the Installer locally. DO NOT 

run the Installer from another location or machine, such as a 

network file server. 

2. Double-click on the appropriate installation program. The 

installation program is based on the operating system you have 

installed. 

3. View the Read Me file and click Continue. 

4. Click Install. Files are copied to your local hard drive. 

5. Click Restart (OS 9) or Quit (OS X).  

How to install 4-Sight 

FAX Client 
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Upgrading from Previous Versions  

The installation program handles all upgrade issues. 

What's Next? 

Before you can start using 4-Sight FAX Client, you must configure 

your 4-Sight FAX client.  Chapter 2 details these procedures.   
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2. Configuring 4-Sight Fax Client 

In this chapter: 

Topic Page 

Getting Started 10 

Connecting and Logging into a 4-Sight FAX 

Server 

11 

Fine-Tuning Login and Notification Preferences 14 
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Getting Started 

1. The 4-Sight FAX Server must be installed and running on your 

network. 

2. A complete installation of 4-Sight FAX Client on your 

computer. 

3. A user login, with a name and password that was created for 

you on the 4-Sight FAX Server. Contact your network or 

office administrator for your login and password. 

Note: 

 You must know the public static external IP address of the 4-

Sight FAX Server if you are connecting to from outside your 

local area network (LAN). 

Three items that 

you MUST have in 

order to send and 

receive faxes:  
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Connecting and Logging into a 4-Sight FAX Server 

You must indicate to your 4-Sight FAX Client which 4-Sight FAX 

Server you want to use to send and receive fax messages. 

 

This dialog box appears if you do not have at least one 4-Sight 

FAX Client account (user) defined, such as when you launch 4-

Sight FAX Client for the first time, or if you have deleted all 

accounts on this machine. 

Note: 

 See How do I? on page 12 for more information. 
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Do the following to continue: 

Click é Toé 

New 

Account 

Create an account for this 4-Sight FAX Client 

running on this machine.  Select your account name 

by choosing the fax server from the 4-Sight FAX 

Server list. 

This can be the same or different from your 

username. 

Work 

Offline 

Create faxes now.  4-Sight FAX Client 

automatically puts them into the Pending folder.  

When you connect to the 4-Sight FAX Server, you 

can send the faxes immediately or schedule them 

for a later time. 

1. Click New Account to: 

 Select the 4-Sight FAX Server you want to use to send and 

receive faxes. 

 Select your user name that was created for you by the fax 

administrator for the FAX Server you selected. 

How do I? 
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2. Select the FAX Server you want to use from the Fax Servers 

list. 

 

3. Select Get Users and then select your name from the User 

Name list.  Decide from the following options: 

Option Description 

Account 

name 

Decide how you want your name to appear on your 

window when you login. 

Remember 

password 

Allows the Fax Client to remember your password so you 

are not asked for it each time you log into 4-Sight FAX 

Client. 

Password Enter the password that was assigned to you when logging 

into the selected FAX Server. 

Login 

automatically 

Allows the Fax Client to automatically log you into the 4-

Sight FAX Server when you launch the client. 

4. Click Create. 

5. Select your user name from the Folder List. 

6. Click the  icon to start. 
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Fine-Tuning Login and Notification Preferences  

Use the Account Settings dialog box to define the following: 

Tabé What you can configureé 

Account  Display user name. 

 IP Address and Port of the 4-Sight FAX Server. 

 Alias. 

 Login options. 

Options  The default folder to view when you login. 

 Show faxes for all users.  (If you have the 4-Sight FAX 

Server privilege.) 

 The default cover page to use when sending faxes. 

 View which options and features are currently available. 

Email  Fax Forward to Email option. 

Notification  How often (in minutes) the FAX Client should check the 

FAX Server for new messages. 

 Whether or not you want to be notified when you receive 

or send a fax. 

 Allow notification of activity for either all or only your 

outgoing or incoming messages. 

 Notification method, either a pop-up window, sound or 

both. 
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1. Launch and log into the 4-Sight FAX Client application. 

2. Access the Account [name] dialog box: 

 From the Folders List, double-click on your user name next to 

the  icon.   

 Select the name from Folders list, and then from the 

Windows pull-down menu, select Properties. 

3. Click the Account tab. You can configure the following: 

 Click Apply when done. 

Option Description 

Name Decide how you want your name to appear when you 

login. 

Server Displays the current 4-Sight FAX Server you are 

using to send and receive messages. 

Address You can view or change the current IP address of  4-

Sight FAX Server you are using to send and receive 

messages. 

Port You can view or change the (communication) Port 4-

Sight FAX Server is currently using.  The default is 

port 8008. 

The Account Tab 

How do I ? 
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Option Description 

User Name You can view or change your user name. Changing 

this can cause login failure problems if it does not 

match the user name listed on the Fax Server. 

Alias Enter or select an alias (alternate display name) when 

sending faxes. 

Remember 

Password 

Allows the Fax Client to remember your password so 

you are not asked for it each time you log into 4-Sight 

FAX Client. 

Password Enter the password that was assigned to you when 

logging into the selected FAX Server. 

Login 

automatically 

Allows the Fax Client to automatically log you into 

your account displayed in the Folder List when you 

launch the client. 

 

Notes: 

 If you selected Remember Password and/or Login 

Automatically, changes will take affect the next time you 

launch 4-Sight FAX Client.  

 To automatically log into the selected 4-Sight FAX 

Server when you launch the application, select BOTH the 

Remember Password (even if you have not defined a 

password) and the Login Automatically options.  

 IP Address and Port Number can only be changed when 

you are logged out of the fax server. 

 Changing your User Name can create login problems if 

this does not match is the user name set up on the Fax 

Server. 
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1. Launch and log into the 4-Sight FAX Client application. 

2. Access the Account [name] dialog box: 

 From the Folders List, double-click on your user name next to 

the  icon.   

 Select the name from Folders list, then from the Windows 

pull-down menu, select Properties. 

3. Click the Options tab. You can configure the following: 

 Click Apply when done. 

 

Option Description 

Login Folder You can decide which queue (incoming, or outgoing) 

you want 4-Sight FAX Client to display when you login.  

Show faxes for 

all users 

Allows you to view all incoming and outgoing faxes 

from all users on this FAX Server,  

Note: 

The Options Tab 

How do I ? 
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Option Description 

 You can only view faxes for all users if you have 

the Full Queue Access feature enabled on the Fax 

Server. 

 

 

Option Description 

Default cover 

page 

Allows you to define a default cover page to use when 

sending messages.   

Note: 

 You can change which cover page you want within 

the Fax Composer. 

Default Fax 

Line 

Allows you to select a different fax line, if this FAX 

Server has more than one fax line. The default is Next 

Available. 

Phone Card Allows you to configure a default phone card number to 

use when accessing the 4-Sight FAX Server from a 

remote location, such as from a hotel, bypassing the 

additional hotel phone and toll charges. 

Privilege/Value Displays which options or features are currently 

available or not available. 
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1. Launch and log into the 4-Sight FAX Client application. 

2. Access the Account [name] dialog box: 

 From the Folders List, double-click on your user name next to 

the  icon.   

 Select the name from Folders list, then from the Windows 

pull-down menu, select Properties. 

3. Click the Email tab. You can configure the following: 

 Click Apply when done. 

 

Option Description 

Enable fax 

forwarding 

to email 

Enable this feature to receive an Email with the fax 

attached as a PDF file. 

Note: 

 You must purchase the ”Email Suite” feature 

separately.  

The Email Tab 

How do I? 
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Option Description 

Email 

Address 

(Incoming) 

Enter your Email address where you receive Email 

messages. 

Email 

Address 

(Outgoing) 

Enter the Email address where you want messages 

forwarded.  Faxes are sent to this email address in PDF 

format.  

 

 

1. Launch and log into the 4-Sight FAX Client application. 

2. Access the Account [name] dialog box: 

 From the Folders List, double-click on your user name next to 

the  icon.   

 Select the name from Folders list, then from the Windows 

pull-down menu, select Properties. 

3. Click the Notifications tab. You can configure the following: 

 Click Apply when done. 

 

The Notification Tab 

How do I ? 
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Option Description 

Show 

notifications 

of activity 

Allows you to receive notification (either by a pop-up 

window, sound or both) that either a fax has been 

received, or that a fax has been successfully sent, failed 

or rejected. 

Refreshes the 

queues every 

_ minutes 

You can define, in minutes, how often you want the 4-

Sight FAX Client to check the 4-Sight FAX Server for 

any new activity (incoming and outgoing). 

Give me 

notification 

of: 

Depending on your FAX Server defined user rights (Full 

Queue Access) you can either receive notification on 

Allé activity or just your own (Myé) 

Outgoing - All faxes sent successfully, failed or rejected 

by the intended recipient 

Incoming – any new faxed received.  

Option Description 

Notification 

method 

You can receive either a pop-up message window, 

computer sound or both when an activity occurs for the 

selected account. 

 

Logging In from Outside Your Local Area Network (LAN)  

4-Sight FAX Client and the Fax Server communicate with each 

other using the TCP/IP protocol. Because of this, you are able to 

log into the Fax Server from anywhere in the world using a Client 

computer that has Internet access. The computer on which the Fax 

Server is running must have a static public (external) IP address. 

The procedure for setting up this type of login is the same as if you 

were logging in from within your LAN.  

 

Whatôs Next? 

Review the following sections for more information about sending 

and receiving faxes, managing your address books and working with 

the queues and folders. 

To doé See pageé 

Sending Faxes 24 

Receiving Faxes 42 

Viewing Faxes 43 
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To doé See pageé 

Working with Address books 52 
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3. Sending Faxes 

In this chapter: 

Topic Page 

Sending Faxes 24 

About Attachments 28 

Including Attachments 28 

Scheduling a Fax 30 

Resending a Fax 32 

 

Sending a Private Fax 

32 

Forwarding a Fax 33 

Rejecting a Fax in Transit 37 

Suspending (Holding) a Fax 37 

Releasing a Suspended Fax 37 
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 Sending Faxes 

The process of sending a document as a fax is a 5-step process: 

Step Process Description 

1 Create a fax 

document 

Create a fax document from most any application, 

or resend/forward an existing fax from within 4-

Sight FAX. 

2 Convert 

document into a 

format suitable 

for faxing. 

If you are creating a fax message from within an 

application (other than 4-Sight FAX), your 

document is converted into a format suitable for 

faxing – a group 4 TIFF image file. This is done 

via the 4-Sight FAX Print Driver. 

If you are creating a fax within 4-Sight Fax, there 

is no need to convert the document into a fax 

format, unless you include attachments. 

3 Select recipients 

and fax details 

This is where you can select your recipients, 

cover page and include attachments you want to 

in the message. You can also schedule to send the 

message at a later time.  Depending on which 4-

Sight FAX Client option you have installed, you 

can decide to send the message as a fax, an Email, 

or both at the same time. 

Note: 

 You must purchase the Email Suite to send 

and receive faxes as Emails. 

4 The fax is sent to 

the 4-Sight FAX 

Server 

The following happens: 

The selected cover page is attached to your fax, 

along with the appropriate information, such as 

name of the contact, etc. 

The fax is placed in the outgoing queue for 

transmission. 

5 Notification Depending on when you scheduled the 4-Sight 

FAX Server to send your fax, you can receive an 

automatic notification of the status of your fax. 

 

Note: 

 You must be logged into the 4-Sight FAX Server to send a 

fax.  If you are not connected to a Fax Server, the fax is 

placed in your Pending folder.  You will have the option 

to send the fax the next time you connect to a 4-Sight 

FAX Server. 

 

How it all works: 
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1. Using the table below, decide how you want to send a fax. 

Send From... Description... 

Most 

applications 
 OS 9.x: If the 4-Sight FAX printer driver is not the default, 

press the <option> key, point to the File menu, and select 

Fax.  

 OS 10.x/Windows: If the 4-Sight FAX print driver is not 

the default, go to the File menu, and select Print. Select 4-

Sight FAX from the printer list.  

 If the 4-Sight FAX printer driver is the default, point to the 

File menu, select Print.  

Proceed to step 2. 

Within 

4-Sight FAX 
 To create a new fax, click the New Fax button   . 

 To Resend an existing fax message (Outgoing queue only), 

click the Resend button . 

 To Forward an existing fax message (Incoming queue, 

Outgoing queue, Sent Faxes and Personal Folders), click the 

Forward button . 

Proceed to step 2. 

Outside of  

4-Sight FAX 
Drag and drop documents onto the 4-Sight FAX Client icon on 

your desktop, or the OS X dock. Multiple documents can be 

dragged onto Fax Client together if you wish to include them in 

the same fax document. 

Proceed to step 2. 

How do I?  
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2. Click the Recipients tab.  Select the recipients from the Current 

Address Book section.  

 You can choose individual contacts and groups from your 

personal Client-based address book, from a Server-based 

address book, or from the Apple Address Book  (OS X 

only) if one is available (Server-based contacts are 

indicated by a blue bullet in the Name column.) You can 

also enter your own recipients, one at a time, in the Quick 

Entry fields.   

To... Do the followingé 

Include a 

contact Select the contact(s) you want and click .  

 To select multiple contacts (sequential), hold the 

<Shift> key and select the first and last contact. 

 To select multiple contacts (non-sequential), hold the 

<Command> key (use the <Control> key if you are 

on a PC) and select the contacts you want. 

Remove a 

contact Select the contact(s) you want and click .  

 To select multiple contacts (sequential), hold the 

<Shift> key and select the first and last contact. 

 To select multiple contacts (non-sequential), hold the 

<Command> key (use the <Control> key if you are 

on a PC) and select the contacts you want. 

Include a 

contact that is 

not in your 

address book 

Click the Quick Entry  icon.   

You must provide the contact‟s Full Name and Fax Number.  

You can also include the Company Name and Email address.  

These entries will not be added to your address book. 

Note: 

 The Fax Server‟s Smart Dialing feature does not apply to 

any fax numbers you enter in the Quick Entry fields. Be 

sure to enter these numbers exactly as they should be 

dialed, including a “1” if long distance, or any codes and 

prefixes required for international dialing. 

 

5. Click the Cover Page tab and select or enter the following: 

 Decide if you want to send this fax as the currently 

logged-in user name or as another user from the pull-

down menu next to Sender. 
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 Decide if you want to send this message as a Fax, Email 

or both.  You must have purchased the Email Suite to 

send messages as Emails. 

 Select the Cover Page you want to use. 

 Enter a Subject for this fax message. 

 Assign a Priority to this fax message. 

 Decide if you want to send this message as a Private Fax.  

Select this option if you do not want anybody to see or 

have a record of this message. You must have permission 

from the Administrator to send Private faxes. 

6. Use the following chart to continue your setup: 

To... You must... 

Provide 

additional 

comments 

Select a Cover Page to include additional comments. Enter 

your comments in the Comments text box.  

Tip: 

 Click on the Annotation tool icon  to include 

additional mark-ups. See Annotating Messages on 

page 46 for more information. 

Include any 

attachments Click the Attach button . You can attach multiple 

documents to the fax message, but only one document at a 

time. 

See Including Attachments on page 28 for more 

information. 

Insert Data 

into Billing 

Fields 

If your Administrator has activated any of the three 

customizable Billing Fields on the Fax Server, these will 

appear under the Comments section. Complete the 

information for each field as required. 

7. Click the Options tab and select from the following options: 

 Decide which Fax Line you want to use to send your fax.  

This option is useful if more than one fax line is available 

and if one fax line is unavailable or busy and unable to 

send your fax now. 

 Decide if you want to make use of your Phone Card to 

send this message. 

 Decide when you want to Schedule your fax to be sent.  

  Click Send Now to allow 4-Sight FAX Server to 

process and transmit the fax immediately. 
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 Click Send Later to schedule 4-Sight FAX Server to 

send the message at a later time.   

8. Click Send . 

About Attachments 

An attachment is a printable file that is appended to your fax 

message. Attachments always follow the cover page, if one is used. 

A printable file is practically any file from a word processor, 

spreadsheet or graphics program that you can print to a printer. 

Executable and JAR files are examples of non-printable files. 

Use attachments to include additional information that you would 

otherwise have to send as a separate message. Attaching a 

document allows you to quickly send information such as letters, 

charts, pictures or other documents as faxes. 

Within the Composer, click the Attach button  and select the 

printable files, one at a time, to include with the fax. You can 

include as many attachments as you want. Each file attachment is 

converted into a fax (TIFF) image file on your local computer and 

appended to the end of the fax. If you attach more than one file to 

the fax, the attachments appear in the order they were selected.  

Including Attachments 

 

 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

2. Prepare a fax for sending. See Sending Faxes on page 24 

for more information. 

What is an 

Attachment? 

Why should I use 

Attachments? 

How do  

Attachments work? 

How do I? 
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3. Click the Attach button  to locate a document to 

include in this fax. Click Open.  

The document is opened in the application that was used 

to create it, or the currently selected default application 

for that file type. Although a print command is 

automatically issued using the 4-Sight FAX printer driver, 

you must select the print range and click Print. The 

document is then converted into an image file suitable for 

faxing. The file is attached to the fax message. You can 

preview the attachment(s) in the viewer section of the 

Compose New Fax Window, under the Fax Details tab.  

4. When done, click the Send button.  

Notes: 

 If your machine does not have the appropriate 

software to open and print the document or file, then 

you cannot include it as an attachment. 

 You can add as many documents as you want, but 

only one at a time. 
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Scheduling a Fax 

 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

2. Use the following chart to continue scheduling: 

From theé Follow these steps: 

Outgoing Queue  Access the Outgoing Queue and 

select a fax, with a status of 

Waiting that you want to schedule 

for some time in the future. 

 Click the Edit button . 

 Click the Options tab. Proceed to 

step 3. 

Pending Faxes  Access the Pending Queue and 

select a fax that you want to 

schedule for some time in the 

future. 

 Click the Edit button . 

 Click the Options tab. Proceed to 

step 3. 

Fax Composer Click the Options tab.  You can decide 

the following: 

 Send Now  

 Send Later. Proceed to step 3.  

How do I? 
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3. Select a different time and date (year, month, and day) to 

send the message. 

4. Use the following chart to continue: 

From theé Follow these steps: 

Outgoing Queue Click Apply. 

Fax 

Composer/Pending 

Faxes 
Click the Send button . 
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Sending a Private Fax 

Use the Private Fax option if you want to send a message and you 

do not want anybody to see or have a record of it. 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server and click New Fax.  

2. Prepare a fax for sending. See Sending Faxes on page 24 

for more information. 

3. Click the Recipients tab, select or enter recipients,  

 From then click the Cover Page tab and select or enter the 

required information, then select the Private Fax check 

box 

4. Click the Options tab and decide which fax line to use, 

phone card information, if necessary, and then schedule 

(now or later) the message to be sent.. 

Notes: 

 Only you will see or have a record of your private fax 

being sent.  

 The Private Fax option is valid for only the current 

(one-time) fax. If you want to send more than one 

private fax, you must select the Private Fax option 

for each new fax. This option must be enabled from 

the Fax Server. 

Resending a Fax 

You can resend a fax that failed to get transmitted if it reached the 

maximum number of retries as defined on the FAX Server, or if 

you edited the recipient information. 

1. Launch the 4-Sight FAX Client application and log into the  

4-Sight FAX Server and click on the Outgoing Queue button.  

2. Select the fax you want to resend and click the Resend button. 

  

Tip: 

 Click the Edit button  to verify you have the 

correct name, fax number and company name. You 

can also view details about the fax, including the total 

number of pages, the original sender of the fax and 

the date the fax was created.  

How do I? 

How do I? 
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Notes: 

 You can only resend a fax from the Outgoing Queue. 

 You can only Resend one fax at a time. 

 

Forwarding a Fax 

You can Forw-ard (or resend) a message to other recipients that 

were not originally on the recipient distribution list.  

1. Launch the 4-Sight FAX Client application and log into the 4-

Sight FAX Server. 

2. You can forward a fax message from the Incoming Queue, 

Outgoing Queue, Sent Faxes folder, or from a Personal 

Folder you have created. 

3. Select the fax you want to forward and click the Forward 

button .   

4. Click on the Recipients tab. Select the recipients from the 

Current Address Book section.  

 You can choose individual contacts and groups from your 

personal Client-based address book, from a Server-based 

address book, or from the Apple Address Book (OS X 

only)  if one is available (Server-based contacts are 

indicated by a blue bullet in the Name column.) You can 

also enter your own recipients, one at a time, in the Quick 

Entry fields.   

To... Do the followingé 

Include a 

contact Select the contact(s) you want and click .  

 To select multiple contacts (sequential), hold the 

<Shift> key and select the first and last contact. 

 To select multiple contacts (non-sequential), hold the 

<Command> key (use the <Control> key if you are 

on a PC) and select the contacts you want. 

How do I? 
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To... Do the followingé 

Remove a 

contact Select the contact(s) you want and click .  

 To select multiple contacts (sequential), hold the 

<Shift> key and select the first and last contact. 

 To select multiple contacts (non-sequential), hold the 

<Command> key (use the <Control> key if you are 

on a PC) and select the contacts you want. 

Include a 

contact that is 

not in your 

address book 

Click the Quick Recipient  icon.   

You must provide the contact‟s Full Name and Fax Number.  

You can also include the Company Name and Email address 

if you want.  These entries cannot be added to your address 

book. 

Note: 

 The Fax Server‟s Smart Dialing feature does not apply to 

any fax numbers you enter in the Quick Entry fields. Be 

sure to enter these numbers exactly as they should be 

dialed, including a “1” if long distance, or any codes and 

prefixes required for international dialing. 

 

5. Click the Cover Page tab and select or enter the following: 

 Decide if you want to send this fax as the currently 

logged-in user name or as another user from the pull-

down menu next to Sender. 

 Decide if you want to send this message as a Fax, Email 

or both.  You must have purchased the Email Suite to 

send messages as Emails. 

 Select the Cover Page you want to use. 

 Enter a Subject for this fax message. 

 Assign a Priority to this fax message. 

 Decide if you want to send this message as a Private Fax.  

Select this option if you do not want anybody to see or 

have a record of this message. You must have permission 

from the Administrator to send Private faxes. 

6. Use the following chart to continue your setup: 



Sending and Receiving Faxes Page 35 

 

Soft Solutions, Inc.  4-Sight FAX Client v7.5 

To... You must... 

Provide 

additional 

comments 

Select a Cover Page to include additional comments. Enter 

your comments in the Comments text box. 

Tip: 

 Click on the Annotation tool icon  to include 

additional mark-ups. See Annotating Messages on 

page 46 for more information. 

Include any 

attachments Click the Attach button . You can attach multiple 

documents to the fax message, but only one document at a 

time. 

See Including Attachments on page 28 for more 

information. 

Insert Data 

into Billing 

Fields 

If your Administrator has activated any of the three 

customizable Billing Fields on the Fax Server, these will 

appear under the Comments section. Complete the 

information for each field as required. 

7. Click the Options tab and select from the following options: 

 Decide which Fax Line you want to use to send your fax.  

This option is useful if more than one fax line is available 

and if one fax line is unavailable or busy and unable to 

send your fax now. 

 Decide if you want to make use of your Phone Card to 

send this message. 

 Decide when you want to Schedule your fax to be sent.  

  Click Send Now to allow 4-Sight FAX Server to 

process and transmit the fax immediately. 

 Click Send Later to schedule 4-Sight FAX Server to 

send the message at a later time.   

8. Click Send . 

Notes: 

 About forwarding messages and cover pages: 

 If you forward a fax from the Outgoing Queue or 

Sent Folder, the original cover page (if one was 

initially used) is included. 

 If you forward a fax from your Personal Folder the 

original cover page (if one was initially used) is not 

included. 
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 You must be logged into the 4-Sight FAX Server to send a 

fax.  If you are not connected to a Fax Server, the fax is 

placed in your Pending folder.  You will have the option 

to send the fax the next time you connect to a 4-Sight 

FAX Server. 
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Rejecting a Fax in Transit 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server.  

2. Access the Outgoing Queue and locate the fax that is in 

progress of being sent. 

3. Click the Reject button . The fax is stopped. 

 

Suspending (Holding) a Fax 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

2. Access the Outgoing Queue and locate the fax that you 

want to suspend or hold and click the Hold button . 

Fax messages that are on hold are indicated by the date 

field, which changes from the current date to 

<suspended>. 

Note: 

 You can only Hold (suspend) and Release faxes from the 

Outgoing Queue. 

 

Releasing a Suspended Fax 

1. Launch the 4-Sight FAX Client application and log into 

the  

4-Sight FAX Server. 

2. Access the Outgoing Queue and select the currently 

suspended (held) fax and click the Release button . 

The date field displays the date the fax was originally 

scheduled. Otherwise, the current date is displayed and 

the date is displayed without Italics. 

 

How do I?  

How do I?  

How do I?  
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Email To Fax 

The email to fax feature works by sending an email from your 

email client to a specific email address on your network. Your 

FAX Server Administrator will establish a specific email address 

on your network to check. The 4-Sight FAX Server will then check 

this email account at specified intervals, converting any emails to a 

fax. We recommend an email address of „fax@yourdomain.com‟. 

Formatting Requirements: 

The subject line of the email will be the subject of your fax, and 

any attached .PDF or .PNG files will be included in the fax. 

1. Open a new email in your email client (Apple Mail, 

Entourage, Thunderbird, etc.) 

2. Address the email to the address you assigned on your 

network to handle email to fax (i.e. 

fax@yourcompany.com) 

3. Use this format in the body of the email: 

Recipient Name:Company:Fax Number 

#CoverPageNumber# 

Comments 

##  

 Examples: 

   1: With a cover page number 

Jane Doe:CompanyX:15555552222 

#2# 

These are sample comments 

##  

   2: Without a cover page number 

Jane Doe:CompanyX:15555552222 

## 

These are sample comments 

## 

 

4. Send your email. 

5. User of the email to fax feature will receive an email from 

the fax server providing feedback (i.e., successful, 

unsuccessful, etc.). 

NOTES:  

o If no cover page number is entered, but 

comments are provided, the server will 

automatically choose cover page #1. 

How do I?  
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o Supported file formats are “.PDF” and “.PNG” 
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4. Receiving Faxes 

In this chapter: 

Receiving Faxes 42 

Viewing Faxes 43 

Annotating Messages 46 

Printing Faxes 47 

Assigning Faxes 48 

Opening Previously Saved Faxes 49 
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Receiving Faxes 

You can receive and view a new fax message by: 

 Clicking the Refresh icon  to allow the 4-Sight FAX 

Client to check for new (incoming) faxes. 

 Accessing the Incoming Queue. 

 If you have configured your 4-Sight FAX Client to 

display a pop-up window when you receive a new fax, the 

following dialog box appears. 

 

 It is not required that you have the 4-Sight FAX Client 

running, or have any notification options enabled to 

receive a fax at your workstation. However, you will not 

know if you have received a fax until you launch and 

login to the 4-Sight FAX Server.  

 If you do not have a DID line, or you did not purchase the 

DID option for 4-Sight FAX, you can assign all incoming 

faxes on each modem to a default user with the 

Automated Line-Based Routing (ALBR) feature. This 

option is activated within the 4-Sight FAX Server. Refer 

to the Administrator's Guide for more information. 

 If you do not designate a specific user to receive incoming 

faxes, then all users with Full Queue Access will receive 

notification of a new fax. Refer to the Administrator's 

Guide for more information. 

Notes: 

 To check for new messages or to view faxes, you must be 

logged into the fax Server. 

 You can Assign faxes from the Incoming Queue to any 

other fax user on the selected 4-Sight FAX Server. 

 New faxes are shown in green until they are viewed. 

Things to keep in 

mind: 
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Viewing Faxes 

Notes: 

 You cannot Resend, Forward, or Assign any saved fax 

that you open and view outside of the 4-Sight Fax Client. 

 To annotate a fax from the fax viewer, you must click the 

Resend, Forward icons.   

 

 You can do the following when viewing a fax: 

Button/ 

Field 

Function 

 Save a fax to another location on your hard drive or network. 

 

 Print the fax to the current or default printer. 

 Permanently delete the fax from 4-Sight FAX Client. 

Warning: 

 You cannot “undo” this action. 

 To Resend an existing fax message (Outgoing queue only). 

You can resend a fax that failed to be transmitted if it reached the 

maximum number of retries as defined on the FAX Server, or if you edited 

the recipient information. 

How do I? 
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Button/ 

Field 

Function 

 To Forward an existing fax message (Incoming queue, Outgoing queue, 

Sent Faxes and Personal Folders). 

You can Forward (or resend) a message to other recipients that were not 

originally on the recipient distribution list.  

Button/ 

Field 

Function 

 Assign an incoming fax to another fax user on the 4-Sight FAX Server. 

This option is only available if you view a fax from the Incoming Queue. 

 Temporarily halt the transmission of the selected fax message. 

 Prevent the 4-Sight FAX Server from transmitting the selected fax 

message. 

 Access the online help system. 

 
Move directly to any page of a fax. 

 
Move backward to the previous page in the fax message. 

 
Move forward to the next page in the fax message. 

 
View the fax: 

 Fit page 

 Fit Width 

 Fit Height 

 Zoom: 25%-200% 

 
Increase zoom magnification in increments of 25%.  

 
Decrease zoom magnification in increments of 25%.  

 
Rotate the fax page in increments of 25 degrees to the left. 

 
Rotate the fax page in increments of 25 degrees to the right. 

 
Rotate the fax page in increments of 180 degrees to the left. 

 
View the next message from the current queue. 

 
View the previous message from the current queue. 

Notes: 

 The Assign button is only available when viewing an 

incoming fax. 
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 You can only assign a fax message to another 4-Sight 

FAX user. 

 You cannot save a rotated fax as being rotated.  It will 

save as it was originally displayed. 
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Annotating Messages 

You can only annotate a fax that you just created, or any existing 

fax that you want to Forward, Resend and schedule for some time 

in the future.  

Note: 

 You can only annotate a fax from the Fax Composer. 

 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

Under the Folder List, click on your user login name. 

2. Create a new fax, or select an existing fax that you want to 

Forward or Resend for sometime in the future. 

3. From the Fax Composer, click the Annotate icon . 

The Annotation floating tool bar appears. Use the 

following annotation tools to mark-up the message. 

Button Function 

 
Reposition the fax within the window. 

 
Create free-hand mark-ups with a Black colored pen. 

 
Create typed “sticky notes” or  comments within the fax. 

 
Create free-hand mark-ups with a White colored pen. 

 
Erase any mark-ups created with any annotation tool. 

4. Click the Send button .  

Notes: 

 You can include as many mark-ups as you want to the fax. 

 You cannot do the following: 

o Move a mark-up. 

o Change the angle of text 

 The eraser tool only removes mark-ups made with the 

annotation tool.   

 How do I? 
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 The original fax content cannot be changed, other than 

what you do with the any annotation tool. 

Printing Faxes 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

Under the Folder List, click on your user login name. 

2. View a received fax by accessing the Incoming Queue or 

a Personal folder (if you moved the fax from the Incoming 

Queue), then double-click on the fax. 

3. Click the Print button . 

Note: 

 You must view the fax message before you can print a 

hard copy. 

How do I?  
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Assigning Faxes 

 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server.  

2. View the fax that you want to assign by double-clicking 

on its listing or by selecting it from the Incoming Queue 

and clicking the View button. 

3. Click the Assign button  and select the current 4-Sight 

FAX user(s) that you want to view this fax message. If 

you want, you can also change the From and Subject 

text. 

4. Click OK. 

Notes: 

 You can only assign faxes to other 4-Sight FAX Client 

users. 

 The Assign option is only available for Incoming Faxes. 

 If the Fax Forward to Email option is purchased and 

enabled for the assigned user, that user will receive an 

Email with the fax attached as a PDF file. 

How do I? 
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Opening Previously Saved Faxes 

 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

2. On the File menu, click Open Fax. 

3. Locate and click on the fax you want to view. 

The fax appears in the Fax viewer. 

Use the Attachment Viewer to view the fax. When you are 

done, you can send the fax message to the contact(s) you 

have selected.  

How do I? 





Managing Your Address Books Page 51 

 

Soft Solutions, Inc.  4-Sight FAX Client v7.5 

 5. Managing Your Address Books 

In this chapter: 

Topic Page 

About Address Books 52 

Opening and Creating Address Books 53 

Creating, Modifying and Deleting Address 

Book Contacts 

53 

Creating, Modifying and Deleting Address 

Book Groups 

57 

Searching an Address Book 59 

Importing Address Books 61 
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About Address Books 

Although you can have multiple address books on your client 

machine, you can only display and use one address book at a time. 

You can do the following with Address Books: 

 Locate a personal or global address book entry to edit or 

view. 

 Add and delete address books. 

 Add, modify and delete your personal address book 

contacts.  

 Create local groups consisting of contacts from your 

address book. Use groups to send the same message to 

multiple contacts at the same time. 

 Import an existing 4-Sight FAX version 4 address book, 

or a tab-delimited text file that was created or exported 

from another application.  

 Unless the 4-Sight FAX administrator granted you 

specific rights to do so, you cannot delete or Modify 

Server-based address book contacts or the Apple Address 

Book from the Client. You also cannot create contact 

groups using Server address book contacts.  

 Groups can only be made up of saved Client address book 

contacts. 

 Client address book contacts are specific to your fax 

Client installation, and therefore are not available to other 

fax Client users. 
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Opening and Creating Address Books 

Although you can have multiple address books, only one address 

book is displayed and available at a time.   

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

2. Use the following chart to continue: 

To... Then... 

Create a new 

Address Book 

On the File menu, point to New and 

select Address Book.  

Open an existing 

Address Book 

On the Tools menu, click Select 

Address Booké.  Locate the address 

book you want to use. 

 

Notes: 

 When you create a new address book, 4-Sight FAX Client 

automatically saves the current address book to the default 

location; Documents on MACs and My Documents on 

Windows. 

Creating, Modifying and Deleting Address Book Contacts 

(Entries) 

 

How do I? 
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The following table indicates what the address book icons indicate: 

Address book 

Icon 

Description 

 Personal address book entry. 

 Server address book entry. 

 Group address book entry. 

 Apple address book entry. 

 

Note: 

 If your were given the appropriate 4-Sight FAX Server 

privileges, you can also add (save), delete, and modify fax 

server address book entries.    

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

2. From the Folders List, click on the Address Book, located 

below the Sent Faxes folder. 

3. Use the following chart to continue: 

To... Do the following: 

Create a new 

contact 

On the File menu, point to New and select 

Contact, or click  from within the 

Address Book.  Proceed to step 4. 

Modify an existing 

contact 

Double-click any contact. Continue to step 4. 

Delete a contact Select the contact you want to remove and 

click  . 

4. Provide the appropriate information, from each tab, to 

create or modify an address book entry. 

How do I? 
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From 

theé 

Provide or modify the following contact 

informationé 

Contact 

tab  

Full Name - The first and last name of the contact. 

First/Last Name - The first and last name of the contact. 

Salutation - Mr., Mrs., Ms., Dr., Dean and Professor. 

You may also add your own. 

Company - Name of the company or organization where 

this contact is employed. 

Title - The contact‟s professional title in the company. 

Smart Dialing - Click this option to allow the Fax 

Server to attach the appropriate prefix dial code(s) as 

well as any long distance digits when necessary. If you 

do not click this button, you must supply all necessary 

dialing information (prefix codes and long distance 

digits) yourself. 

Country (code) – The international code that identifies 

from which country you are sending this message. 

Fax (Area-Num) - Provide the area code or city code 

and then the fax number in the appropriate fields. 

Email – The Email address of the intended receipt(s). 

Category - An additional method for organizing or 

grouping your contacts. 

Address 
tab  

Address 1 - Enter the street address of the contact. 

Address 2 - Enter additional mailing information here. 

City - Enter the name of the city or township of the 

contact 

State/Province - Enter the name of the state or province 

of the contact. 

Postal Code - Enter the postal or zip code of the contact. 

Phone Number - Enter the phone number of the contact. 

Other tab Custom 1-3 - Use these fields to capture additional 

information about the contact. 
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From the bottom of each New/Modify Contact tabé 

Save to 

address 

book 

By default, all address book entries are saved to the 

local address book. 

Note: 

 If your were given the appropriate 4-Sight FAX 

Server privileges, you can also add (save), 

delete, and modify fax server address book 

entries.    

5. Click OK. 

Notes: 

 You can have as many personal address books as you 

want, however, you can only have one address book 

active (displayed) within 4-Sight FAX Client at one time. 

 You must provide at least a name (first and last) and a fax 

number. 

 If you do not click the Smart Dialing option, you must 

supply all necessary dialing information, such as a “1” for 

dialing long distance or  “011” for dialing international.  

 Server-based address book contacts are identified with a 

bullet to the left of the name.  

 Unless the 4-Sight FAX administrator granted you 

specific rights to do so, you cannot Delete or Modify 

contacts from the Server-based address book or from the 

Apple address book from within the 4-Sight FAX client. 

 Your personal address book contacts are specific only to 

your fax Client account and are therefore not available to 

other fax Client users. 
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Creating, Modifying and Deleting Address Book Groups 

 

  

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

2. Select the personal address book that contains the groups 

you wish to manage. 

3. The following chart describes your current options for 

managing groups: 

To... Then... 

Create a new 

group 

Select a contact (or multiple contacts) from your 

address book. 4-Sight FAX Client assumes that you 

want those contacts included in your new group. 

On the File menu, point to New and select  

Group, or click the New button. 

Proceed to step 4 to add contacts to this group. 

Modify an 

existing group 

Double-click on a group name.  

Proceed to step 4. 

Delete a group Select the group you want to permanently remove 

from your address book and press the icon. 

4. Provide or change the Group Name. 

How do I? 
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5. Use the following chart to continue:  

To... Then... 

Add contacts to your 

group 

A list of available contacts from your current 

personal address book appears in the Available 

list box. You can multi-select contacts by 

pressing the Command key for Macintosh or 

the Ctrl key for Windows and clicking on the 

desired contacts.  

Drag the selected contacts into the created 

group. 

Remove contacts 

from your group 

A list of selected contacts from your current 

personal address book appears in the Selected 

list on the right. You can select multiple 

contacts and remove them from a group by 

pressing the Command key for Macintosh or 

the Ctrl key for Windows and click left.  

Click the  icon. 

6. Click OK. 

 

Tip: 

 You can select multiple sequential contacts by selecting 

the first contact, hold down the <Shift> key and select the 

last contact. All contacts in that range are selected.  

Notes: 

 You can include as many groups to your personal address 

book as you want. 

 You cannot create groups using the Server-based address 

book contacts.  Is this true?  

 You cannot create groups within existing groups. 

 Removing a contact from a group does NOT remove the 

contact from your address book. However, if you remove 

a contact from the address book, it is also deleted from 

any groups it belongs to. 
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Searching an Address Book 

 

 

 

 

 

 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

Under the Folder List, click on your address book or the 

group that you want to search. 

2. Select the field and search operator you want to use, and 

provide the appropriate input to define your results. The 

following chart displays your options: 

Fields Search operators 

 Name 

 Company 

 Fax Number 

 Category 

 Starts with 

 Ends with 

 Is 

 Is empty 

 Contains 

 Does not contain 

 

How do I? 

Search 

input 

Search results 

Fields and 

Search operators 



Page 60 Managing Your Address Books 

 

4-Sight FAX Client v7.5 Soft Solutions, Inc. 

60 

3. The filtered address book contacts are displayed. 

4. To remove the filter, clear the search input field. 

Notes: 

 The search option filters address book contacts for display 

purposes only. You cannot import address books with the 

filter you selected. 

 Each search is performed only on the current address 

book, not including any groups you may have. To only 

search for names in a group, you must first select that 

group from the Folder List. 
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Importing Address Books 

1. On the File menu, select Import. 

2. Choose the type of address book you want to import. You 

can choose a 4-Sight FAX version 4 or a tab-delimited 

text file, which you may have exported from another 

application. Locate the file, and click Import. 

3. If you import a Version 4 address book, the contacts are 

immediately inserted into your current Client address 

book. All fields are matched to your current address book 

automatically. 

4. If you select Delimited file, an interface will appear that 

allows you to map the fields of your tab-delimited file to 

those in the 4-Sight FAX Address Book. See Using the 

Mapping Interface on page 62 for more information. 

 

How do I?  
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Using the Mapping Interface 

 

Highlight the first Target field in the right column of the window. 

Then choose one Source field from the left column (your list of 

headers) that best matches the Target field. Click Map.  Your 

Source field now becomes an Import field and moves into the 

mapping column. Repeat the process until all of your headings are 

mapped, and then click Import. 

Notes: 

 First and Last names are automatically copied, combined 

(first name <space> last name) and placed into the Name 

field of your Client address book. The reason for this is 

because the Fax Client window and Fax Composer only 

display the Name field. 

 Make sure that your tab-delimited address book has the 

correct field heading listed in the very first row of each 

column. Otherwise, your list will not be properly 

imported. 
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6. Managing the Queues and Folders 

In this chapter: 

Topic Page 

About the Queues and Folders 64 

Working with the Incoming Queue 65 

Working with the Outgoing Queue  67 

Searching the Incoming and Outgoing Fax Queues 70 

Working with the Pending Faxes Folder  72 

Working with the Sent Faxes Folder  74 

Working with the Personal Folders  75 

Searching the Various Fax Folders (Sent Faxes, 

Pending Faxes and Personal Folders) 

77 

Managing Faxes 78 

Managing Reports 81 
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About the Queues and Folders 

Button Queue/Folder Click this button to ... 

 

Outgoing Display information about the 

status of faxes that have 

already been sent or are 

currently being sent. 

 

Incoming Display information about the 

status and history of received 

faxes. 

 

Pending Display information about the 

status of faxes that have not yet 

been sent.  

These include faxes that have 

been created and "sent" while 

you were offline or not 

connected to the fax Server.  

 
Sent Display information about the 

status and history of sent faxes. 

 

User-defined 

Personal 

Folder(s) 

Display faxes that you have 

copied from the Incoming or 

Outgoing queue. 

 

Address Select current Address Book. 

You can only have one address 

book displayed at one time.  

See About Address Books on 

page 52 for more information. 

Notes: 

 You must have a user account and be logged into the  

4-Sight FAX Server to view the Outgoing and Incoming 

Queues.  

 The Show All option is only available if Full Queue 

Access has been granted to you by the 4-Sight FAX 

Administrator. 
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Working with the Incoming Queue 

Use the Incoming queue to display information about the status and 

history of fax messages that you have successfully received. The 

chart below shows the tools that are available when the Incoming 

Queue is selected: 

Button / 

Icon 

Name Use this to... 

  

Log in Log into the 4- FAX Server via the 4-Sight Fax Client, 

enabling you to send and receive messages. 

 

Log out Log out of the 4-Sight Fax Client. 

 

New Fax Create a New Fax 

See Sending Faxes on page 24 for more information.  

 

View View the selected fax message. 

See Viewing Faxes on page 43 for more information. 

 

Assign To assign fax messages to another  

4-Sight Client user. 

See Assigning Faxes on page 48 for more information. 

 
File Copy the selected fax message(s) to personal folder.  

See Filing Faxes to Personal Folders on page 79 for 

more information. 

Note: 

 If you do not have a personal folder, the New User 

Folder dialog appears. Provide a name for this 

folder and click OK. 

 

Refresh Update the Incoming Queue list. 

 
Forward Forward the selected fax to a different contact. See 

Forwarding a Fax on page 33. 

 

Delete Permanently remove the fax message from the 4-Sight 

FAX Server. 

See Deleting Faxes and Address Book Contacts on 

page 80 or more information. 

 

Help Access the online help system. 

What you can do 

from the 

Incoming Queue:  
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The following describes the columns in the Incoming queue. 

Item: Displays... 

From  The Company or person who initiated the fax. 

To  The intended 4-Sight FAX Client recipient of 

the fax message. 

Subject  The subject or title of the fax message. 

Date  The date and time at which the fax message 

was received by the 4-Sight FAX Server.  

Pages The total number of pages. 

Status  The status of fax message: Fax messages can 

have the following status: 

Converting - processing the raw data and 

creating a TIFF (image file) format. 

Received - Indicates the complete fax was 

received. 

Printed - Indicates that the fax message was 

sent to a printer of your choice. 

 

What the Incoming 

Queue Displays: 
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Working with the Outgoing Queue  

Use the Outgoing queue to display information about the status and 

history of fax messages that you have sent.  

You can do the following from the Outgoing Queue: 

Button Name Use this button to... 

 

Log in/out Log into the FAX Server to send and receive messages. 

 

New Fax Create a New Fax 

See Sending Faxes on page 24 for more information. 

 

View View the selected fax message. 

See Viewing Faxes on page 43 for more information. 

 

Edit 

  

You can do the following: 

 Change the Name, Fax Number and Company of 

the fax message contact, as well as the Subject. 

 You can also Schedule when you want the fax 

message to be transmitted.  

See Scheduling a Fax on page 30 for more information. 

 

Hold Temporarily halt the transmission of the selected fax 

message. 

See Suspending (Holding) a Fax on page 37 for more 

information. 

 
Release Allow 4-Sight FAX Server to continue transmitting a 

suspended fax message. 

See Releasing a Suspended Fax on page 37 for more 

information. 

 

Refresh Update the Outgoing Queue list. 

 
Forward Forward the selected fax message to a different list of 

contacts other than the original list.  

 
Resend Allow the 4-Sight FAX Server to attempt to send a fax 

message with a current status of Rejected, Suspended or 

Failed.  

See Resending a Fax on page 32 for more information. 

 
Reject Prevent the 4-Sight FAX Server from transmitting the 

selected fax message. 

 

What you can do from 

the Outgoing Queue:  
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Button Name Use this button to... 

 

Delete Permanently remove the fax message from the 4-Sight 

FAX Server. 

 

Help Access the online help system. 

 

 

The following describes the columns in the Outgoing queue. 

 

Item: Displaysé. 

Pos 

(Position) 

The position of each fax in the Server queue. The 

Server processes faxes on a first in first out basis.  

Note: 

 Priority faxes are inserted into the queue 

before non-priority ones. 

To  The intended contact(s) of the fax message. 

Subject  The subject or title of the fax message. 

From  The originator of the fax message. 

Date  The date and time at which the fax message was sent 

from the 4-Sight FAX Server.  

Note: 

 The Date field also displays the future date 

and time when a Scheduled fax message will 

be sent. 

What the Outgoing 

Queue Displays: 
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Item: Displays... 

Status  The status of a fax message: Fax messages can have 

the following status: 

Waiting - the fax message has not yet been processed 

by the 4-Sight FAX Server. 

Imaging - the fax message is being converted into 

TIFF format, which is suitable for faxing. 

Imaged - the fax message has been converted and is 

ready to be sent.  

Prep x/y - the x page of y pages is currently being 

prepared, i.e., 1/4 is the first page of four. 

Page x/y - the fax message is being transmitted. The 4-

Sight FAX Server displays the current page being sent 

(the x) and the number of pages to be faxed (the y).  

Failed - the number of attempts to transmit the fax 

message exceeded the number of attempts defined by 

the fax administrator. 

Max Retries - the fax message has failed to be 

transmitted after the maximum number of times, as 

defined by the fax administrator on the 4-Sight FAX 

Server.  

Suspended - the fax message has been suspended by a 

user or by the administrator and will remain in the 

queue until manually unsuspended, archived or 

deleted. 

Rejected - the fax message has been rejected. This 

could be due to a user manually rejecting the fax, or 

because the Server has been configured to reject 

grayscale faxes. 

Sent - the fax message has been successfully 

transmitted. 

Tips: 

 To view another user's sent faxes, click the Show All 

check box. 

 To view a fax, double-click on its listing in the queue. 

 Private faxes can only be viewed by their owner.  
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Searching the Incoming and Outgoing Fax Queues  

 

 

 

 

 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server.  

 Under the Folder List, click on the Incoming Faxes 

or Outgoing Faxes button.  

2. Decide if you want to search only your faxes or 

everyone's faxes. 

 Click the Show All option to view and search 

through all faxes. 

 Clear the Show All option to view and search 

through only your faxes. 

3. Select a field and search operator, and then provide the 

appropriate input to define your search. 

How do I? 

Search input 

Search results 

Headings and 

Search Parameters 

Fax viewer 
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Fields Search Operators 

 Pos. 

 To 

 Subject 

 From 

 Date 

 Status 

 Starts with 

 Ends with 

 Is 

 Is empty 

 Contains 

 Does not contain 

 Is less than 

 Is greater than 

4. The filtered faxes are displayed. 

5. To remove the filter, clear the field that you entered 

information to enable the search. 

Notes: 

 The Show All option is only available if you have the Full 

Queue Access granted by the 4-Sight FAX Administrator. 

 Use the Is less than (<) and Is greater than (>)operators 

when searching on the position (Pos.) of a fax. 
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Working with the Pending Faxes Folder  

Use the Pending Faxes folder to display information about fax 

messages that have been created while you were off-line (not 

connected to the fax Server).  

Button Name Use this button to... 

 

New  

Fax  

Create a New Fax 

See Sending Faxes on page 24 for more information. 

 

View View the selected fax message. 

See Viewing Faxes on page 43 for more information. 

 

Edit 

  

You can do the following: 

 Edit any aspect of a Pending fax. 

 You can also Schedule when you want the fax message 

to be transmitted. The default scheduling is „send now‟. 

See Scheduling a Fax on page 30 for more information. 

 

Delete Permanently remove the fax message from the 4-Sight FAX 

Server. 

 

Help Access the online help system. 

 

The following describes the columns in the Pending Faxes queue. 

Item: Displays... 

To The intended recipient(s) of the fax message. 

Number The fax number of the intended recipient(s). 

Subject  The subject matter or title of the fax message. 

From The originator of the fax message. 

Date The date and time that the fax was sent to the Fax 

Server.  

Note: 

 If a fax is scheduled for a later time, the Date 

field shows the date and time when the fax 

will be sent. 

What you can do from 

the Pending Faxes 

Folder:  
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Tips: 

 To view other users‟ faxes, click the Show All check box. 

 To view a fax, double-click on it. 

Notes: 

 The Show All option is only available if you have the Full 

Queue Access granted by the 4-Sight FAX Administrator  

 You can remove fax messages from the Pending Faxes 

queue by selecting it and clicking the  icon. 
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Working with the Sent Faxes Folder  

Use the Sent Faxes folder to display information about the status 

and history of fax messages that you have successfully sent.  

The following chart shows what you can do from the Sent folder: 

Button Name Use this button to... 

 

New  

Fax 

Create a New Fax. 

See Sending Faxes on page 24 for more information. 

 

View View the selected fax message. 

See Viewing Faxes on page 43 for more information. 

 
Forward Forward the selected fax message to a different list of 

recipients other than the original list.  

See Forwarding a Fax on page 33 for more information. 

 

Delete Permanently remove the fax message from the 4-Sight FAX 

Server. 

 

Help Access the online help system. 

 

 

The following describes the columns in the Sent queue. 

Item: Displays... 

To The intended recipient(s) of the fax message. 

Fax 

number 

The number the fax Server dialed to send the fax message. 

Subject  The subject matter or title of the fax message. 

From  The originator of the fax message. 

Date  The date and time at which the fax message was sent to the 

4-Sight FAX Server.  

Note: 

 If a fax is scheduled for a later time, the Date 

field shows the date and time when the fax will 

be sent. 

What the Sent Queue 

Displays: 
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Working with the Personal Folders  

Use the Personal folder to keep fax messages that you do not want 

to lose or have readily available. 

The following chart shows what you can do from a 

Personal Folder: 

Button Name Use this button to... 

 

New Fax Create a New Fax 

See Sending Faxes on page 24 for more information. 

 

View View the selected fax message. 

See Viewing Faxes on page 43 for more information. 

 
Forward Forward the selected fax message to a different list of contacts 

other than the original list.  

 

Delete Permanently remove the fax message from the 4-Sight FAX 

Server. 

 

Help Access the online help system. 

 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

2. Do one of the following to continue: 

To Description 

Create a new 

personal 

folder 

 From the File menu, click New and select Folder. 

 Enter the name of your personal folder and click OK. 

Your personal folder appears underneath the 4-Sight FAX Address Book. 

Note: 

 You can have as many personal folders as you want.  

Rename a 

personal 

folder 

 Double-click on an existing personal folder.  A dialog box appears. 

 Enter the new name of this folder and click Apply. 

Delete a 

personal 

folder 
Select the personal folder you want to permanently delete and click . 

Warning: 

 You cannot undo this action. 

 All items in this folder will be deleted. 

What you can do from 

the Personal Folder:  

How do I? 
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Tips: 

 See Searching the Various Fax Folders (Sent Faxes, 

Pending Faxes and Personal Folders) on page 77 for 

more information. 

 See Filing Faxes to Personal Folders on page 79 for 

more information. 
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Searching the Various Fax Folders (Sent Faxes, Pending 

Faxes and Personal Folders) 

 

 

 

 

 

 

 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

 Under the Folder List, click on the icon for Pending 

Faxes, Sent Faxes or your personal fax folder. 

2. Select a field and search operator, and then provide the 

appropriate input to define your search. 

3. The filtered faxes are displayed. 

Note: 

 To remove the filter, clear the search input field. 

 

How do I? 

Search 

input 

Search results 

Fields and Search 

Operators 

Fax Viewer 
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Managing Faxes 

Managing faxes includes the following tasks: 

Task: Description: 

Assigning faxes To assign fax messages to a 4-Sight Client user. 

See Assigning Faxes on page 48 for more information. 

Filing faxes to a 

personal folder 

To File faxes from the Incoming queue to a folder you 

created for safe personal keeping. 

See Filing Faxes to Personal Folders on page 79 for 

more information. 

Opening a fax To view a fax in the Fax Composer.  

See Opening Previously Saved Faxes on page 49 for 

more information. 

Saving a fax To keep a permanent copy of a fax message outside of 4-

Sight FAX.  

See Saving Faxes on page 80 for more information. 

Deleting a fax and 

address book contacts 

Permanently remove a fax message from your hard 

drive. 

See Deleting Faxes and Address Book Contacts on 

page 80 for more information.  

Edit the properties of a 

fax in the Outgoing 

queue  

To change the contact fax information, schedule the fax 

for the future and view the fax. 

See Working with the Outgoing Queue on page 67 for 

more information. 
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Filing Faxes to Personal Folders 

 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

 Under the Folder List, click on the Incoming Faxes 

button.  

2. Select the fax you want to file to your personal folder.  

3. Click the File icon . 

 If you have more than one personal folder, decide 

which folder you want to file the fax message into. 

4. Click OK. 

How do I? 



Page 80 Managing the Queues and Folders 

 

4-Sight FAX Client v7.5 Soft Solutions, Inc. 

Saving Faxes 

 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

2. Do the following to view the fax:  

 To view a received fax, access the Incoming Queue 

or a Personal folder, if you moved the fax from the 

Incoming Queue. Double-click on the fax listing. 

 To open a saved fax, select Open Fax from the File 

menu. Locate the fax message and then click Open. 

3. Once the viewer is open, click Save from the File menu. 

4. Choose where you want to save the fax and click Save. 

Deleting Faxes and Address Book Contacts 

1. Click on the appropriate queue or folder from which you 

want to permanently remove fax messages or address 

book contacts. 

2. Select the fax messages or address book contacts to you 

want to delete. 

3. Click the Delete button . 

How do I? 

How do I? 
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Notes: 

 You can delete client address book contacts, as well as 

4-Sight FAX Server contacts with the appropriate 4-

Sight FAX Server rights. 

 If you want to delete an Apple based address book 

contact, you must the contact directly from the Apple 

address book.  

Managing Reports 

Use the 4-Sight FAX Client reporting capabilities to view, sort/filter and 

print activity for the Outgoing and Incoming queues.  

Outgoing Fax Reports 

You can filter your results based on the status of the outgoing fax; Sent, 

Failed and Rejected. You can also decide whether or not to include those 

faxes that were suspended by the user. 

 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

2. On the Tools menu, click Outgoing Faxes Report.  

3. Decide the time from at which your report should begin. 

The following chart displays your options: 

Scope Base the Outgoing Faxes Report oné 

Faxes of 

Today 

Faxes sent or attempted to be sent within the 

current calendar day.  

Faxes of 

this week 

Faxes sent or attempted to be sent within the 

current calendar week. 

How do I? 
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All Faxes All faxes regardless of date. 

Faxes of 

Selected 

Dates 

Faxes sent or attempted to be sent within the 

dates you specify.  

 

 

4. Choose the Filters you want to use. 

 Filters Description 

Sent Those faxes with a status of Sent. 

Failed Those faxes with a status of Failed. 

Rejected Those faxes with a status of Rejected. 

Include 

Suspended 

Include those faxes with a status of Suspended. 

 

5. Provide the name that you want to appear at the top of the 

printed report. The default name is Outgoing Faxes 

Report.  

6. View the report.  

7. The printed report will only print what is visible in the 

columns.  

8. Use the following chart to continue:  

Clické Toé 

Print Receive a hard copy of the report. 

Export Save the report information to a tab-delimited text 

file. 

Use the tab-delimited text file to import the 

information into another 3
rd

 party spreadsheet or 

reporting application. 
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Note: 

 You can run reports on your faxes, however, if you have 

the appropriate 4-Sight FAX Server privilege – Full 

Queue Access, then you can print a report for all faxes on 

the server.  
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Incoming Fax Reports 

You can filter your results based on the time and date you specify. 

 

1. Launch the 4-Sight FAX Client application and log into 

the 4-Sight FAX Server. 

2. On the Tools menu, click Incoming Faxes Report.  

3. Decide the time from which you want to base your report. 

You can choose from the following options: 

Scope Base the Incoming Faxes Report oné 

Faxes of 

Today 

Faxes received within the current calendar 

day.  

Faxes of This 

Week 

Faxes received within the current calendar 

week. 

All Faxes All faxes regardless of date. 

Faxes of 

Select Dates 

Faxes received within the dates you specify.  

4. Provide the name that you want to appear at the top of the 

printed report. The default name is Incoming Faxes 

Report.  

5. View the report.  

6. The printed report will only print what is visible in the 

columns.  

 

 

 

How do I? 
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7. Use the following chart to continue:  

Clické Toé 

Print Receive a hard copy of the report. 

Export Save the report information to a tab-delimited 

text file. 

Use the tab-delimited text file to import the 

information into another 3
rd

 party spreadsheet 

or reporting application. 

 





Fine Tuning Page 87 

 

Soft Solutions, Inc.  4-Sight FAX Client v7.5 

7. Fine Tuning 

In this chapter: 

Topic Page 

Preferences 88 
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Preferences 

Use Preferences to fine-tune your 4-Sight FAX Client.  

Tab: What you can doé 

Fax  Define outgoing fax priority. 

 Default cover page (fax) resolution. 

 Option to select from multiple accounts on the client machine 

from which to send messages. 

 Choose whether to save a copy of outgoing faxes to the Sent 

Faxes folder. 

 Define the default zoom when viewing fax messages. 

Feedback  Enable/Disable 4-Sight FAX to display a confirmation message 

box when deleting a fax message. 

 Enable/Disable 4-Sight FAX to play sounds when an event 

occurs, such as sending or receiving a fax message. 

Advanced  Select the default language you want 4-Sight FAX Client to use. 

 Decide if you want 4-Sight FAX Client to automatically check 

for updates. 

 Choose your Country of origin.  

 Decide what you want to view when you launch and log into 4-

Sight FAX.  You can open the main window or launch the Fax 

Composer. 
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Fax Preferences (Outgoing Faxes) 

 

1. Launch 4-Sight FAX Client.   

 Mac – On the Fax Client pull-down menu, select 

Preferences.   

 Windows ï On the Tools pull-down menu, select 

Preferences.   

2. Click the Fax tab.  Decide which option(s) you want. 

Option Description: 

Default Priority Define outgoing fax resolution and priority.  You can select 

from the following options: 

 Bulk 

 Important 

 Normal 

 ASAP 

 Urgent 

 

Cover page 

resolution  

Default cover page (fax) resolution.  You can select Fine, 

which provides greater detail, good for graphics, although 

it takes longer to send, or Standard, which is good for text 

only and is faster to send. 

Show ñAccountò 

popup 

Select this if you have the option to select from multiple 

accounts on the client machine.  When sending faxes, you can 

select which account you want to send messages.  Otherwise, 

only currently logged in or last account used is displayed. 

Save copy of 

outgoing in Sent 

Faxes folder 

Enable/Disable the option to save successfully transmitted 

messages to Sent folder. 

 

How do I? 
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Option Description: 

Default Zoom Define the default zoom when viewing fax messages.  You 

can select from the following view options: 

 Fit Page  Fit Width 

 Fit Height  Choose from 25% 

through 200% 

magnification 
 

3. Click OK. 

Tip: 

 Click Reset to return all options and values to their 

default settings.  
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Feedback Preferences 

 

1. Launch 4-Sight FAX Client.   

 Mac – On the Fax Client pull-down menu, select 

Preferences.   

 Windows ï On the Tools pull-down menu, select 

Preferences.   

2. Click the Feedback tab.  Decide which option(s) you want. 

Option Description: 

Confirm before 

deleting 

Enable/Disable the option to display a confirmation message 

box when deleting a fax message. 

Play sounds Enable/Disable the option to choose if you want to play 

sounds when an event occurs, such as sending or receiving a 

fax message. 

3. Click OK. 

Tip: 

How do I? 
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 Click Reset to return all options and values to their default 

settings 

 Advanced Preferences 

 

1. Launch 4-Sight FAX Client.   

 Mac – On the Fax Client pull-down menu, select 

Preferences.   

 Windows ï On the Tools pull-down menu, select 

Preferences.   

2. Click the Advanced tab.  Decide which option(s) you want. 

Option Description: 

Language Select which language you want to use in the 4-Sight Fax 

Client. 

Country Select the country from which you are using 4-Sight Fax 

Client.  

If you make use of Smart Dialing, the appropriate country 

code is used when dialing. 

Check if an 

update is available 

at launch 

Select this option if you want 4-Sight Fax Client to 

automatically check if an update is available. 

When Fax Client 

is activated 

Decide which 4-Sight Fax Client you want to appear when 4-

Sight Fax Client is started. You can select the following: 

How do I? 
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 Open the client window  

 Open Fax Composer window  

Include contacts 

from system 

address book 

Decide if you want to make use of 4-Sight Fax Server based 

address book entries. 

Note: 

 If your were given the appropriate 4-Sight FAX 

Server privileges, you can also add (save), delete, 

and modify fax server address book entries.    

3. Click OK. 

Tip: 

 Click Reset to return all options and values to their default 

settings 
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 Appendix A: Need Assistance? 

In this chapter: 

Topic Page 

Contacting Technical Support 96 
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Contacting Technical Support 

There are three ways to get technical support: 

 

Type of Support 

 

Details 

Requires Support 

Agreement 

Phone support 9am-5pm Eastern Time 

770-457-9400  

International support available. 

Yes 

Email support support@softsinc.com Yes, once the 30-

day installation 

support period 

expires. 

Fax support 770-454-9800 Yes, once the 30-

day installation 

support period 

expires. 

 

 

 



Appendix: Need Assistance? Page 97 

 

Soft Solutions, Inc.  4-Sight FAX Client v7.5 

 

Index 

A 

Address Books 

about · 48 

creating contacts · 50 

creating groups · 54 

deleting contacts · 50, 78 

deleting groups · 54 

importing · 58 

modifying contacts · 50 

modifying groups · 54 

searching · 56 

Advanced preferences · 90 

Annotating Faxes · 42 

Assigning Faxes · 44 

Attachments 

about · 28 

adding to a fax · 28 

C 

Contacting Technical Support · 

94 

D 

Deleting Faxes · 78 

F 

Fax Reports 

incoming · 82 

outgoing · 79 

Fax Viewer · 39 

Faxes 

Annotating · 42 

Features 

new in version 7.0 · 2 

Feedback preferences · 89 

Filing Faxes 

to personal folders · 77 

Forwarding Faxes · 33, 40 

I 

Incoming Faxes 

searching the queue · 68 

Incoming Queue · 63 

Installation · 7 

L 

Logging in 

from outside your LAN · 21 

M 

Managing Faxes · 76 

Marking-up Faxes 

Annotating · 42 

N 

New Features in version 7.0 · 2 

O 

Opening Saved Faxes · 45 

Outgoing Faxes 

priority · 87 

resolution · 87 

searching the queue · 68 

P 

Pending Faxes 

searching the folder · 75 

using the folder · 70 

Personal Folders 

searching · 75 



Page 98 Index 

 

 

4-Sight FAX Client v7.5 Soft Solutions, Inc. 

working with · 73 

Preferences 

advanced · 90 

fax resolution · 87 

feedback · 89 

general · 86 

priority · 87 

Print Driver 

adding to OS X Print Center 

· 7 

Printing Faxes · 43 

Private Faxes · 32 

Q 

Queues and Folders · 62 

R 

Receiving Faxes 

overview · 38 

Rejecting Faxes · 36 

Resending Faxes · 32 

S 

Saving Faxes · 78 

Searching 

fax folders · 75 

fax queues · 68 

Sending Faxes 

including attachments · 28 

Sent Faxes 

searching the folder · 75 

using the folder · 72 

Software Requirements · 6 

Suspended Faxes 

how to resume · 36 

Suspending Faxes · 36 

T 

Technical Support 

contact information · 94 

U 

Upgrading 

from version previous 

versions · 8 

V 

Viewing Faxes 

in Fax Viewer · 39 

 


	Table of Contents
	Welcome to 4-Sight FAX Client
	In this chapter:
	Introduction
	New 7.5 Client Features:
	Existing Features:


	1. Installing 4-Sight FAX Client
	In this chapter:
	Software Requirements
	Minimum Software Requirements

	Installation
	How to install 4-Sight FAX Client

	Upgrading from Previous Versions
	What's Next?

	In this chapter:
	Getting Started
	Three items that you MUST have in order to send and receive faxes:

	Connecting and Logging into a 4-Sight FAX Server
	How do I?

	Fine-Tuning Login and Notification Preferences
	The Account Tab
	How do I ?
	The Options Tab
	How do I ?
	The Email Tab
	How do I?
	The Notification Tab
	How do I ?
	Logging In from Outside Your Local Area Network (LAN)

	What’s Next?

	3. Sending Faxes
	In this chapter:
	Sending Faxes
	How it all works:
	How do I?
	About Attachments
	What is an Attachment?
	Why should I use Attachments?
	How do  Attachments work?

	Including Attachments
	How do I?

	Scheduling a Fax
	How do I?

	Sending a Private Fax
	How do I?

	Resending a Fax
	How do I?

	Forwarding a Fax
	How do I?

	Rejecting a Fax in Transit
	How do I?

	Suspending (Holding) a Fax
	How do I?

	Releasing a Suspended Fax
	How do I?

	Email To Fax
	How do I?



	4. Receiving Faxes
	In this chapter:
	Receiving Faxes
	Things to keep in mind:
	Viewing Faxes
	How do I?

	Annotating Messages
	How do I?

	Printing Faxes
	How do I?

	Assigning Faxes
	How do I?

	Opening Previously Saved Faxes
	How do I?



	5. Managing Your Address Books
	In this chapter:
	About Address Books
	Opening and Creating Address Books
	How do I?

	Creating, Modifying and Deleting Address Book Contacts (Entries)
	How do I?

	Creating, Modifying and Deleting Address Book Groups
	How do I?

	Searching an Address Book
	How do I?

	Importing Address Books
	How do I?

	Using the Mapping Interface


	6. Managing the Queues and Folders
	In this chapter:
	About the Queues and Folders
	Working with the Incoming Queue
	What you can do from the Incoming Queue:
	What the Incoming Queue Displays:

	Working with the Outgoing Queue
	What you can do from the Outgoing Queue:
	What the Outgoing Queue Displays:

	Searching the Incoming and Outgoing Fax Queues
	How do I?

	Working with the Pending Faxes Folder
	What you can do from the Pending Faxes Folder:

	Working with the Sent Faxes Folder
	What the Sent Queue Displays:

	Working with the Personal Folders
	What you can do from the Personal Folder:
	How do I?

	Searching the Various Fax Folders (Sent Faxes, Pending Faxes and Personal Folders)
	How do I?


	Managing Faxes
	Filing Faxes to Personal Folders
	How do I?

	Saving Faxes
	How do I?

	Deleting Faxes and Address Book Contacts
	How do I?


	Managing Reports
	Outgoing Fax Reports
	How do I?

	Incoming Fax Reports
	How do I?



	7. Fine Tuning
	In this chapter:
	Preferences
	Fax Preferences (Outgoing Faxes)
	How do I?

	Feedback Preferences
	How do I?

	Advanced Preferences
	How do I?



	Appendix A: Need Assistance?
	In this chapter:
	Contacting Technical Support

	Index

